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What does BLAST stand for ?

(A) Biometric Location Algorithm
System Tool

(B) Biological Lab
Software Technique

Analysis

(C) Basic Local Alignment Search
Tool

(D) Bioinformatics
Search Tool

Logical Array

What is the primary role of the Entrez
system in bioinformatics databases ?

(A) Performing sequence alignment

(B) Searching and retrieving
biological data from databases

(C) Processing images

(D) Performing statistical compu-

tations

Which of the following tools is

commonly used for retrieving

biological sequences from databases ?

(A) MATLAB
(B) Adobe Photoshop
(C) BLAST

(D) SRS
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What is the primary objective of gene

sequencing in molecular biology ?

(A) Editing digital images

(B) Determining the precise order of
nucleotides in a DNA sequence

(C) Measuring protein concentration

(D) Constructing phylogenetic trees

Which technology is commonly used

for high-throughput gene sequencing ?

(A) Sanger sequencing

(B) NGS

(C) Northern blotting

(D) Western blotting

What is the primary goal of protein

sequencing ?

(A) To determine the sequence of
amino acids in a protein

(B) To create a digital image

(C) To measure the pH of a solution

(D) To edit genetic material
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Which method is commonly used for

protein sequencing ?

(A) Gel electrophoresis
(B) PCR
(C) Edman degradation

(D) Southern blotting

What is the primary function of

ClustalW in bioinformatics ?

(A) Multiple sequence alignment of

DNA or protein sequences

(B) Sequence submission to

databases

(C) Genome annotation
(D) Protein structure prediction

What is the main purpose of similarity

searching in bioinformatics ?

(A) To find similar sequences in a
database

(B) To edit biological images
(C) To create mathematical models

(D) To store financial data
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What is pair-wise sequence alignment
used for ?

(A)
(B)

Creating 3D models

Comparing two sequences to
identify regions of similarity

(©)

(D) Conducting chemical reactions

Editing genetic material

Needleman-Wunsch algorithm is used
for:

(A)
(B)

(©)
(D)

Local sequence alignment
Database searching
Multiple sequence alignment

Global alignment of biological
sequences

What is multiple sequence alignment ?

(A) Editing
simultaneously

multiple images

(B)

Aligning one sequence with a
3D model

than
sequences to identify regions of

more two

(C) Aligning

similarity

(D)

Aligning chemical formulas
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In bioinformatics, what does MSA
stand for ?

(A) Multiple Sequence Alignment
(B) Molecular Structural Analysis
(C) Medical Statistical Analysis

(D) Microbial Sample Analysis

What is the definition of biostatistics ?

(A) The analysis of financial markets
(B) The study of plant biology

(C) The application of statistics to
biological and health sciences

(D) The study of environmental

sciences

Which of the following is a commonly
used statistical method in biostatistics
for analyzing relationships between

variables ?

(A) Regression analysis
(B) Chromatographic separation
(C) DNA sequencing

(D) Image processing
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Data compilation in biostatistics refers

to:

(A) Collecting and organizing data
for analysis

(B) Performing statistical tests

(C) Interpreting experimental results

(D) Presenting data graphically

In biostatistics, classification refers to :

(A) Physical
samples in a laboratory

categorization  of

(B) Arrangement of data into
meaningful groups or classes for
analysis

(C) Graphical representation  of
variables

(D) Statistical testing of hypotheses

What is tabulation in the context of
biostatistics ?

(A) Arranging data in tables for easy
interpretation

(B) Writing novels
(C) Composing music
(D) Designing clothing
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How is biostatistics applied in life

sciences ?

(A) To analyze experimental data

and draw conclusions

(B) To build computer software

(C) To design vehicles

(D) To construct bridges

What is the primary purpose
of  graphical representation in

biostatistics ?

(A) To visually present data for

easier interpretation

(B) To perform statistical
calculations
(C) To collect experimental data

(D) To store data in databases

Which of the following is a common

graphical representation used in

biostatistics ?

(A) Histogram
(B) Pie chart
(C) Linegraph

(D) All of the above
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23.

24,

What does probability theory in

biostatistics helps to determine ?

(A) To visually display data for

easier interpretation

The color of a flower

(B)

(C) The likelihood of an event

occurring

(D) The shape of an object

Which distribution is commonly used
in biostatistics for modeling binary

outcomes ?

(A) Normal distribution

(B) Binomial distribution
(C) Poisson distribution

(D) Exponential distribution

What is a normal distribution often

referred to as ?

(A) Triangle curve
(B) Square curve
Bell curve

(©)

(D) Zigzag curve
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25.

26.

27.

drawback of
methods in

What is a potential

relying on statistical

biological research ?

(A) Data may be misinterpreted if
not properly analyzed

(B) Statistics always provide
flawless conclusions
(C) AIll  experimental errors are

removed through statistics

(D) Statistics are limited to use in
chemical studies only

How can the limitations of statistics be
mitigated in life sciences research ?
(A) By avoiding data collection

(B) By ignoring statistical errors

(C) By using outdated methods
(D) By using rigorous data collection
and analysis methods

A study records the weights (in kg) of
8 patients as : 50, 55, 60, 65, 70, 75,
80, 85. What is the mean weight of the
patients ?

(A) 65kg
(B) 67.5kg
(C) 70Kkg
(D) 72.5kg
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28.

29.

30.

31.

In the data set 45, 50, 55, 60, 65, what
is the median value ?

(A) 50
(B) 55
(C) 60
(D) 65

A bag contains 3 red, 7 blue, and 10
green balls. If one ball is drawn at
random, what is the probability of
selecting a green ball ?

(A) 3/20

(B) 7/20

(C) 10/20

(D) 13/20

When two fair six-sided dice are
rolled, what is the probability of
obtaining a total sum of 7 ?

(A) 5/36
(B) 6/36
(C) 7/36
(D) 1/12

In biometry, what is a population ?

(A) A collection of all individuals or
items under study

(B) A subset of a larger group
(C) A group of animals

(D) A sample of data points
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What is random sampling ?

(A) Selecting samples based on

researcher preference

(B) A method where each member
of the population has an equal
chance of being selected

(C) A method used only for small
populations

(D) Choosing samples in a specific
sequence
What is stratified sampling ?

(A) Sampling only the first few
individuals

(B) Randomly selecting individuals
without any grouping

(C) Dividing the population into
subgroups and sampling each
subgroup

(D) Selecting every nth individual
from the population

In systematic sampling, how are

samples selected ?

(A) By stratifying the population and
selecting from each group

(B) By randomly picking individuals
from the population

(C) By choosing only the first
individuals

(D) By selecting every nth individual
from the population
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What does a frequency distribution
represent in statistical analysis ?

(A) A summary of how often each
value appears in a dataset

(B) A method for calculating mean
values

(C) A step involved in hypothesis
testing

(D) A graphical tool for regression
analysis

Which of the following is NOT a
measure of central tendency ?

(A) Mode

(B) Mean

(C) Median

(D) Variance

What is the arithmetic mean ?

(A) The sum of all values divided by
the number of values

(B) The middle value in a sorted data
set

(C) The value that appears most
frequently in a data set

(D) The difference between the
highest and lowest values
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38.

30.

40.

In a data set, the mode represents
which of the following ?

(A) The middle value
(B) The average of all values

(C) The value that appears most
frequently

(D) The between

maximum and minimum values

difference

What does the coefficient of variation
(CV) measure in a dataset ?

(A) The ratio of standard deviation
to the mean

(B) The difference between the

highest and lowest values

(C) The average of the squared
differences from the mean

(D) The sum of all data points

What is the standard deviation ?

(A) A measure of the dispersion of
data points around the mean

(B) The average value of a dataset
(C) The highest value in a dataset

(D) The median of a dataset
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41.
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What does the standard error of the
mean (SEM) represent ?

(A) The variability of the sample
mean estimate of a population
mean

(B) The total number of data points

(C) The range of the data

(D) The standard deviation of the
data set

What is the primary purpose of the
Chi-square test ?

(A) To find the median of a sample

(B) To calculate the mean of a data
set

(C) To test the association between
two categorical variables

(D) To determine the standard
deviation
Which of the following is a

requirement for applying the chi-
square test ?

(A) The data must be categorical

(B) The data must be normally
distributed

(C) The data must be continuous

(D) The sample size must be small
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44,

45.

46.

Which of the following can be
calculated using MS Excel’s statistical

functions ?

(A) DNA sequencing

(B) Mean,

standard deviation

median, mode, and

(C) Gene editing
(D) Protein synthesis
Which Excel function would you use

to calculate the standard deviation of a
dataset ?

(A) =STDEV()
(B) =AVERAGE()
(C) =SUM()
(D) =MEDIAN()

How can you create a frequency
distribution table in MS Excel ?

(A) By using the Sort feature

(B) By manually entering data into

cells

(C) By using the PivotTable feature

(D) By using the Merge feature
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47.

48.

49.

50.

What is SPSS primarily used for ?

(A) Database management
(B) Video editing
(C) Website development

(D) Statistical analysis

In SPSS, which feature is used to
perform a Chi-square test ?

(A) File > New > Chi-Square

(B) Analyze > Descriptive Statistics
> Crosstabs

(C) Edit > Options > Chi-Square

(D) View> Toolbar > Chi-Square

Which type of data is most appropriate

for statistical analysis in SPSS
software ?

(A) Multimedia data (audio/video)
(B) Quantitative numerical data
(C) Unstructured image data

(D) Raw signal data

20,480 kilobytes (KB) is equal to how

many megabytes ?

(A) 5MB
(B) 10 MB
(C) 20MB
(D) 40 MB
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o o o
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(A) firex
() w1
(C) =
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(18)

Bioinformatics is primarily applied in
biology for :

(A) Studying physical laws

(B) Analyzing and interpreting

biological data and information

(C) Managing financial records

(D) Designing industrial chemical

compounds

Which of the following represents a

major application of bioinformatics in

biological research ?

(A) Developing new programming
languages

(B) Predicting protein structure and
function

(C) Designing mechanical devices

(D) Building
circuits

digital  electronic

Which of the following is an example
of an input device ?

(A) Printer

(B) Monitor

(C) Keyboard

(D) Speaker
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54.

55.

56.

The operating system (OS) in a
computer primarily functions to :

(A) Manage hardware and software
resources of the system

(B) Provide antivirus protection

(C) Create documents and
spreadsheets

(D) Establish internet connectivity

Central Processing Unit (CPU) is

considered as :

(A) Digital computer
(B) Analogue computer
(C) Brain of computer

(D) Power supply

The primary function of a hard disk

drive (HDD) in a computer system is

to :

(A) Perform data processing and
calculations

(B) Provide long-term (non-volatile)
data storage

(C) Offer temporary memory for
executing programs

(D) Interface with external

input/output devices
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(A) ™

(B) W

(C) &% B

(D) =€ few=h
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57.

58.

59.

Which type of computer is used for
personal tasks such as browsing the

internet and word processing ?

(A) Mainframe
(B) Supercomputer
(C) Personal Computer

(D) Minicomputer

Which generation of computers

introduced the use of integrated

circuits (I1Cs) ?

(A) First Generation
(B) Second Generation
(C) Third Generation

(D) Fourth Generation

Which type of memory is non-

volatile and is used for long-term data

storage ?

(A) RAM
(B) ROM
(C) Cache Memory

(D) Hard Disk
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Excel # 91 &t IR &l guifed w7 60.

& fou frafafed § 9 wE-m widse

ST fohar San § 2

(A) F2
(B) F4
(C) F7
(D) F10

Excel § Scatter Chart &1 q&a swm 6L
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(A) SRl & ST &t feem

(B) HHH & WY T @™

(C) TTT-3TeTT SAfOrT 1 Tl el

(D) < OEHS® W & o I B
[EESEL TS

Excel ¥ HMI & Tk JON 1 3TEd 62.

e & fau ®F- wRE STEm
fra S g ?

(A) SUM

(B) COUNT
(C) AVERAGE
(D) MAX

(21)

Which of the following shortcuts is
used to edit the content of a cell in

Excel ?

(A) F2
(B) F4
(C) F7
(D) F10

Scatter Chart in Excel is primarily

used for :

(A) Displaying  proportions  of
categories

(B) Showing trends over time
(C) Comparing discrete categories

(D) Analyzing the relationship

between two quantitative
variables
Which Excel function is used to

calculate the average of a range of

values ?

(A) SUM
(B) COUNT
(C) AVERAGE
(D) MAX
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(B) T
(C) HifeX
(D) firx

frafafed § ¥ =9 faiee =R
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(A) W™

(B) W
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Excel # fFt 9@ H €1 RY & &
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g
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g

(D) Hfsha IaT I T 8 TS |

(22)

63.

64.

65.

Which of the following is an example

of an analog-to-digital conversion

device ?

(A) Microphone
(B) Speaker

(C) Monitor

(D) Printer

Which of the following is a type of

secondary storage device ?

(A) RAM

(B) ROM

(C) Hard Disk

(D) CPU

What happens when you press the

“Enter” key after typing data into a

cell in Excel ?

(A) The cell remains active.

(B) The active cell moves to the next

column.

(C) The active cell moves to the next

row.
(D) The active cell deletes the

content.
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o foman ST € 2
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EHNEERE!|
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(D) St & oY ST YoF Il S
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66.

67.

Combo Chart in Excel is used for :

(A) Displaying multiple chart types

within a single chart

(B) Plotting relationships between
two variables

(C) Representing data using vertical

bars

(D) Showing proportions in a

circular form

What does the “SUM” function in
Excel do ?
(A) Counts the number of cells

(B) Adds up the values in a range of

cells

(C) Finds the smallest value in a

range

(D) Finds the largest value in a range
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68.

69.

70.

What does RAM stand for in computer

terminology ?

(A) Random Access Memory

(B) Read Access Memory

(C) Rapid Access Memory

(D) Real-time Access Memory

Which of the following is an example

of optical storage media ?

(A) USB Flash Drive

(B) DVD

(C) SSD

(D) Floppy Disk

Microsoft Word is an example of

which type of software ?

(A) Operating system software
(B) Application software
(C) Firmware

(D) System utility
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71.

72.

73.

Which of
converts digital

the following devices

signals to analog

signals ?

(A) Modem
(B) Mouse
(C) SSD

(D) Printer

What does the field of genomics
study ?

(A) The structure and function of
genomes

(B) The behavior of molecules in
chemical reactions

(C) The
materials

physical properties of

(D) The anatomy of plants

Which of the following technologies is
commonly used in genomics ?

(A) X-ray crystallography

(B) Next-generation sequencing
(NGS)

(C) Polymerase chain  reaction
(PCR)

(D) Electron microscopy
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(B) SIRTAT THlheH
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74.

75.

76.

Transcriptomics focuses on the study

of which of the following ?

(A) Proteins and their structures

(B) RNA transcripts

(C) Metabolites in cells

(D) Lipid synthesis

Which technique is often used in

transcriptomics to measure gene

expression ?

(A) Western blotting

(B) Mass spectrometry

(C) RNA sequencing (RNA-seq)

(D) ELISA

Proteomics is the large-scale study of
what ?

(A) Lipids

(B) Carbohydrates

(C) Nucleic acids

(D) Proteins

Set-B



77. URiehfHed H dudt § RS @ UgEH
FE % fau s W few fafy
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(A) ST TRIBRREE
(B) IR
(C) A TRmE
(D) TIPS
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(D) Hfes =iee
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TerrEah T
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(C) uferEm
(D) = =i
B170602T

(27)

77.

78.

79.

Which method is commonly used in
proteomics to identify proteins in a

sample ?

(A) Gel electrophoresis
(B) Chromatography

(C) Mass spectrometry
(D) Spectrophotometry

Metabolomics is concerned with the

study of which of the following ?

(A) Lipid profiles in organisms
(B) Metabolites within cells
(C) Protein interactions

(D) Genetic mutations

Which of the following techniques is

commonly  applied to study

small-molecule metabolites in

metabolomics ?

(A) Nuclear Magnetic Resonance
(NMR) Spectroscopy
(B) Polymerase Chain  Reaction
(PCR)
(C) ELISA
(D) Western Blot
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ISR § HifeTeshd oM 3R
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TS W 3fereR ST Y S § 2
(A) Python

(B) Java
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80.

81.

82.

Which programming language is most
widely used for statistical computing

and data analysis in bioinformatics ?

(A) Python
(B) Java
(C) C++
(D) R

Which of the following programming
languages is known for its extensive

use In bioinformatics for data

manipulation and analysis ?

(A) JavaScript
(B) Python
(C) HTML

(D) Swift

In bioinformatics, which language is
commonly used for developing web-

based applications ?

(A) Ruby
(B) Perl
(C) Java

(D) PHP
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83.

84.

85.

Which language is known for its use in

scripting and text processing in

bioinformatics ?

(A)  Perl
(B) COBOL
(C) FORTRAN

(D) SQL

Which of the following is a widely used
bioinformatics library implemented in
Python for sequence analysis and

biological data processing ?

(A) BioPerl
(B) BioJava
(C) BioR

(D) BioPython

What

biological database ?

is the main purpose of a

(A) Storing financial records

(B) Storing and organizing
biological data
(C) Developing software appli-

cations

(D) Creating multimedia content
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86.

87.

88.

Which of the following is an example

of a primary biological database ?

(A) Swiss-Prot
(B) GenBank
(C) Prosite

(D) KEGG

Primary  databases are  mainly

responsible for storing which type of

data ?

(A) Analyzed data
(B) Mathematical models
(C) Software code

(D) Raw experimental data

What type of information is typically
stored in a secondary database ?

(A) Raw sequence data

(B) Annotations and interpretations

of primary data

(C) Financial data

(D) Multimedia files
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(31)

89.

90.

91.

Which of the following is a secondary
biological database ?

(A) NCBI
(B) EMBL
(C) PDB
(D) UniProt

What

database from primary and secondary

distinguishes a composite

database ?

(A) It stores only financial data.

(B) It combines data from multiple
sources.

(C) Itisused for video editing.

(D) It does not contain biological
data.

Which database integrates information

from multiple sources to provide

functional  analysis of  protein

families ?

(A) Prosite
(B) GenBank
(C) PDB

(D) KEGG
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92. HH-W T faow ®F ¥ WM 92, Which  database is  specifically

. . N ~  ~ designed for storin rotein
TRl Sl GBI hid & fau fesmeA g g P

structures ?

e T 2
(A) SHIR (A) GenBank
(B) TSt (WA 221 o) (B) PDB (Protein Data Bank)
(C) shesirST (C) KEGG
(D) FfTsi (D) UniGene
93. o HH WEw & foau fAfafea # & 93, Which of the following is a commonly
o e W used tool for sequence alignment ?
S g ?
(A) = (A) BLAST
(B) THA (B) Excel
(C) RIS (C) Photoshop
(D) sierhe (D) AutoCAD
94. HHE-® HRSW Uk ®I ¥ 94 Which software is widely used for
TR U a & e STEm constructing phylogenetic trees ?
fopan ST § 2
(A) FRASTY (A) Clustalw
(B) M (B) MEGA
(C) e (C) BLAST
(D) TEHIA (D) RASMOL
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(33)

97.

What is the primary function of the

BLAST tool in bioinformatics ?

(A) Sequence alignment and

similarity search

(B) Image editing
(C) Spreadsheet calculation
(D) Database management

Which of the following tools is used

for multiple sequence alignment ?

(A) Clustal Omega
(B) MS Word

(C) MATLAB

(D) SPSS

Which bioinformatics tool is used to

visualize protein structures ?

(A) MEGA
(B) BLAST
(C) PyMOL

(D) Clustalw
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98.

99.

100.

Which tool is commonly used for

genome annotation ?

(A) Artemis

(B) Adobe Photoshop
(C) AutoCAD

(D) Excel

What is the main use of the KEGG

database ?

(A) Storing financial data

(B) Analyzing metabolic pathways
and interactions

(C) Designing graphics

(D) Conducting statistical analysis

What is the full form of NCBI ?

(A) National Center for

Biotechnology Information

(B) National Council for Biological

Integration

(C) National

Bioinformatics and Innovation

Center for

(D) National

Bioinformatics

Committee for
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correct answer and mark the same in the
OMR Answer-Sheet as per the direction :

Example :

Question :

Q1 ® @ © ®
Q2 & ® @ ©
23 ® @ © ©

lllegible answers with cutting and
over-writing or half filled circle will be
cancelled.

Each question carries equal marks. Marks
will be awarded according to the number of
correct answers you have.

All answers are to be given on OMR
Answer Sheet only. Answers given
anywhere other than the place specified in
the answer sheet will not be considered
valid.

Before writing anything on the OMR
Answer Sheet, all the instructions given in it
should be read carefully.

After the completion of the examination
candidates should leave the examination hall
only after providing their OMR Answer
Sheet to the invigilator. Candidate can carry
their Question Booklet.

There will be no negative marking.

Rough work, if any, should be done on the
blank pages provided for the purpose in the
bookilet.

To bring and use of log-book, calculator,
pager and cellular phone in examination hall
is prohibited.

In case of any difference found in English
and Hindi version of the question, the
English version of the question will be held
authentic.

> On opening the question booklet, first check that all
the pages of the question booklet are printed properly.
If there is any discrepancy in the question Booklet,
then after showing it to the invigilator, get another
question Booklet of the same series.

10.

11.

12.

TR § Y W % IR RTed
IW—A, B, C wd@ D g1 wdanef &1 51 =R
famedi 0 O HEl W BT €1 W H OMR
AR-IME § grafed gvd & | 79 7R
‘HT—IT%:

3GTEUT ¢

‘g‘s‘:“o

D @ © O

T2 ® ® ©

w3 D @ © ©®

S IW A1 T W = H1eT A1 agel T
T, AT H ST e g T, 3% i
e s

Jh U9 & 37 UM | 3T Fa W T&l
B, S & STTUR 37k YgH fohd S |

[ SW FHad . T TR, TWTHF (OMR
Answer Sheet) W & fad 1 81 W0 #
fauifta T & eretmen e wdl W fea T
W G &l |

3. TH. R IW-T% (OMR Answer Sheet)
R %o ot forem & 7d sud 3 73 |eft sreen
I FEYHEs qg foran S|

THE IR & SUN qenel et fiersd i
319t OMR Answer Sheet 3ucisdl i & &1
2 UeT wel ¥ TR i | qdemedt o7 @iy
-GG o ST Tohd & |

fitfea aferm =1 81

FE ot T &, T-YRast & 1< H, Th-+E &
forq few w@rett It W 2 foman s =nfew

Tden-we H T, oo, TSR adl
Y TF o ST TN IHehT ITART HEAT Afoid
7

31 & o<t wa Sfis TR # fu=rar 89 &
TN H WY BT SIS TA=0T & /= &I |

HEEYUT : TR @ie W YUHd: St R 3@ o R

YeA-gfEdR & |l g3 wyefidifa ®Y gu g1 oAl
GYTYfeRT # 1E wHT B, A weRie H e
3 S T g TeA-gfdent o R o |



